LENESAS APPLICATION NOTE

RZ/N2L Group

Example of separating loader program and application program projects

Introduction

This application note explains a sample application separating the application into a loader program and an
application program.

The maijor features of the sample program are listed below.

e The program supports two operating modes of the device: xSPI0 boot mode (x1 boot serial flash)
version and 16-bit bus boot mode (NOR flash) version.

e This sample application consists of two separated projects, the loader program and the application
program.

e The loader program is a program for copying the application program from external flash to internal
RAM or external RAM. This is done according to the loader table information (source address,
destination address, size) defined in the loader program.

e The application program is copied and started by the loader program. It performs initial settings and
let the LEDs blink.

Target Devices
RZ/N2L Group

When applying the sample program covered in this application note to another microcomputer, modify the
program according to the specifications for the target microcomputer and conduct an extensive evaluation
and testing of the modified program.
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1. Specifications
1.1 Operating Environment

The sample program covered in this application note is for the environment below.

Table 1.1

Operating Environment

Item

Description

Microcomputer

RZ/N2L Group (R9A07G084M04GBG)

Operating Frequency

CPU : 400MHz (Arm® Cortex®-R52)

Operating Voltage

3.3V/1.8V/1.1V

Integrated Development Environment

¢ Embedded Workbench® for Arm Version 9.50.1
from IAR systems

e e?studio 2024-01.1 (24.1.1) (R20240125-1623)
from Renesas

Operating mode

e xSPI0 boot mode (x1 serial flash)
e 16-bit bus boot mode (NOR flash)

Board

Renesas Starter Kit+ for RZ/N2L

Flexible Software Package (FSP)

Version 2.0.0(For RZ/N series)

RO1AN6737EJ0210 Rev.2.10
Jun 16.2025
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1.2 File Structure
The details of the file structure and contents of this package are show below.

RZN2L_loader_application
—r01an6737jj0210-rzn2l-separating-loader-and-application.pdf
F—r01an6737ej0210-rzn2l-separating-loader-and-application.pdf
——iccarm: for EWARM

—16bitbusboot: sample program for 16 bit boot mode (NOR flash memory)
|  —Loader_application_projects.zip

| —application: project for application program

| —loader: project for loader program

| L—RZN2L_bsp_16bitbusboot_app_loader.eww: EWARM workspace

|
|
|
|
|
| L—xspiObootx1: sample program for xSPI0 boot mode (x1 flash memory)
| L—Loader_application_projects,zip
| —application: project for application program
| —loader: project for loader program
| L—RZN2L_bsp_xspiObootx1_app_loader.eww: EWARM workspace
L—gcc : for e2 studio
—16bitbusboot: sample program for 16 bit boot mode (NOR flash memory)
|  “—Loader_application_projects.zip
| F—RZN2L_bsp_16bitbusboot_app: project for application program
| L—RZN2L_bsp_16bitbusboot_loader: project for loader program
L—xspiObootx1: sample program for xSPI0 boot mode (x1 flash memory)
L—Loader_application_projects.zip
F—RZN2L bsp_xspiObootx1_app: project for application program

L—RZN2L_bsp_xspiObootx1_loader: project for loader program

The files of the package are separated to EWARM and e? studio environment at first level, and to 16 bit
boot mode (NOR flash memory) and xSPI0 boot mode (x1 flash memory) at second level.

Each of the four resulting sample application consists of two projects - one project for the loader program
and one project for the application program.

For the usage procedures of sample program in each development environments, see Appendix
Supplementary Notes on Development Environments.
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1.3 Switch and Jumper Settings

The switch and jumper settings required to run the sample program are shown below. For details on each
setting, see the Renesas Starter Kit+ for RZ/N2L User’s Manual.

Table 1.2 Switch settings

Project SW4-1 SW4-2 SW4-3 SW4-4 Swa-7
16-bit bus boot mode ON OFF ON ON OFF
xSPI0 boot mode ON ON ON ON OFF

Table 1.3 Jumper settings

Project CN8 CN17 CN24 CN25

16-bit bus boot mode - Short 1-2 | Short 1-2 | Short 1-2

xSPI0 boot mode Short 2-3 - Short 2-3 -
RO1AN6737EJ0210 Rev.2.10 Page 5 of 34
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2. Hardware
2.1 Peripheral Functions

Table 2.1 lists the peripheral functions to be used and their applications.

Table 2.1 Peripheral functions and applications

Peripheral function

Application

Clock generation circuit (CGC)

Used as a CPU clock and each peripheral module
clock

Interrupt controller (ICU)

Used for software interrupts (INTCPUOQ)

Bus state controller (BSC)

Used to attach NOR flash memory to CS0 space

Expanded serial peripheral interface (xSPI)

Used to attach Serial flash memory to external
address space xSPI0

General purpose I/O ports

Used to control pins to light LEDs on and off

See the RZ/N2L Group User's Manual: Hardware for basic descriptions.

RO1AN6737EJ0210 Rev.2.10
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2.2 Pins
Table 2.2 lists pins to be used and their functions.

Table 2.2 Pins and Functions

Pin Name Input/Output Function
A1 to A25 Output Address signal output to NOR flash memory
DO to D15 Input/Output | Data signal input and output to NOR flash memory
CSOo# Output Device selection signal output to NOR flash memory attached to CSO space
RD# Output Strobe signal output indicating reading
WEO#/DQMLL Output Write strobe signal output to D15 to D8
WE1#/DQMLU Output Write strobe signal output to D7 to DO
XSPI0_CKP Output Clock output
XSPI0_CS0 Output Device selection signal output to QSPI flash memory attached to CS0O space
XSPI0O_RESETO Output Master reset status output
XSPI0_IO0 ~ Input/Output | Data input / output
XSPIO_IO3
MDO Input Operating mode selection:
MD1 Input e MDO ="L", MD1 = “L”, MD2 = “L” (xSPI0 boot mode)
MD2 Input e MDO =“L", MD1 = “H", MD2 = “L” (16-bit bus boot mode)
P18_2 Output Lighting LEDO on and off
P22_3 Output Lighting LED1 on and off
P04 _1 Output Lighting LED2 on and off
P17_3 Output Lighting LED3 on and off

Note: The mark "#" indicates negative logic (or active low).

R0O1AN6737EJ0210 Rev.2.10 Page 7 of 34
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3. Software
This section is common explanation of EWARM (from IAR systems) and e? studio unless otherwise stated.

In this document, the program included in the loader project is called loader program, and the program
included in the application project is called application program. Loader program and application program
each have startup processing section and main processing section.

3.1 Operation Overview

After the reset is released, the loader program for each operating mode (16-bit bus boot/xSPI0 boot) stored
on the external flash memory (NOR flash/Serial flash) is copied to the internal RAM (BTCM).

After boot processing, the loader program is executed. The loader program copies the application program
from external flash memory (NOR flash/Serial flash) to RAM (System SRAM). As final step of the loader
program the entry point of the copied application program is called. After executing the loader program, the
execution of the application program starts.

Storage area Execution area
BTCM
External flash memory
Loader program
Loader program 1
System SRAM
Application
rogram
prog 2 Application
program

1. After reset release, copy the loader program from external flash memory to

BTCM in boot proccessing.
2. Copy the application program from external flash memory to System
SRAM in loader program processing.

Figure 3.1 Operation overview

R0O1AN6737EJ0210 Rev.2.10 Page 8 of 34
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3.1.1 Loader Program

The loader program performs initial settings such as changing the exception level and setting the clock as
startup processing. Then the main processing is executed. In the main processing, the application
program stored in external flash (NOR flash/Serial flash) memory is copied to RAM (System SRAM)
according to the parameters of loader table. The loader table is a table that the loader program
references when copying the application program. For details on the loader table, see 3.2 Loader Table.
In addition, LEDO turns on to signal the start of copy processing, and LED3 turns on to signal the end of
copy processing. After copy process is complete, the application program is executed.

Figure 3.2 shows operation overview of loader program.

< Start loader program >

Set EL1 exception vector table offset

Return from EL2 to EL1

Initialize stack, FPU, clock, variable, etc

Turn on LEDO

Copy the application program
according to loader table.

Turn on LED3

< Branch to application program >

Figure 3.2  Operation overview of loader program

R0O1AN6737EJ0210 Rev.2.10 Page 9 of 34
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3.1.2 Application Program
The application program performs initial settings such as clock settings, port initialization, and interrupt
settings as startup processing. LEDO and LED3, which turned on during loader program processing, turn
off in port initialization. Then the main processing is executed.
The main processing executed on System SRAM let the LEDs blink.
The LED blinking process is executed by software interrupt (INTCPUQ), and LEDS blink.
Figure 3.3 shows operation overview of application program.

< Start application program >

Set EL1 exception vector table offset

Initialize stack, FPU, clock, variable, etc

< Start software interrupt processinD
CPU MPU, cache, port, Master MPU,

interrupt settings, etc Enable port access

Software interrupt (INTCPUO) setting Turn on/off LED3

P
w

Disable port access

(Finish software interrupt processirD

Generate software interrupt (INTCPUO)

Software delay

Figure 3.3  Operation overview of application program

R0O1AN6737EJ0210 Rev.2.10 Page 10 of 34
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3.2 Loader Table

Loader table is a table that the loader program references when copying the application program. The loader
table defines the parameters required for program copy, and the loader program performs copy processing

according to the table parameters. Multiple loader table entries can be prepared as required, and parameters
can be stored in each table entry.

The loader table has four parameters: copy source address, copy destination address, copy size, and table
enable/disable flag. Table 3.1 shows the details of the loader table parameters.

In this sample program, four loader tables are prepared in loader_table.c of the loader program. The copy
source address depends on the boot operating mode. Tables 3.2 and 3.3 show the loader table parameters
in this sample program.

Table 3.1 Loader table parameters

Argument | Parameter

Description

1 Src Source address of the program to be copied.
2 Dst Destination address of the program to be copied.
3 Size Size of the program to be copied.
4 Enable flag Flag that determines whether the table is enabled/disabled.
If this flag is disabled, copy processing will not be performed even if other
parameters are set.
0: Disable
1: Enable
Table 3.2 Loader table parameters in this sample program (xSPI0 boot mode)
Table Src Dst Size Enable flag
0 0x6010_0000 0x1001_0000 0x0000_2000 0x1
1 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
2 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
3 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
Note Table 1, 2, and 3 are invalid in this sample program. User can change the table as needed.
Table 3.3 Loader table parameters in this sample program (16-bit bus boot mode)
Table Src Dst Size Enable flag
0 0x7010_0000 0x1001_0000 0x0000_2000 0x1
1 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
2 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
3 OxFFFF_FFFF OxFFFF_FFFF OxFFFF_FFFF 0x0
Note Table 1, 2, and 3 are invalid in this sample program. User can change the table as needed.

RO1AN6737EJ0210 Rev.2.10
Jun 16.2025
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3.3 Memory Map
3.3.1

Program Placement in Flash Memory

Tables 3.4 and 3.5 show the program placed in the flash memory of this sample program. Flash memory
address depends on the operating mode. At the start of debugging, the program is downloaded to flash

memory. Each program is copied to the load destination address by boot processing and loader program
processing and executed on RAM.

Table 3.4 Program placement in flash memory and load destination address (xSPI10 boot mode)

Flash memory address

Contents

Load destination address

0x6000_0000

Parameters for the loader

0x6000_004C

Loader program

0x0010_2000 (BTCM)

0x6008_0000

Loader table

0x6010_0000

Application program

0x1001_0000 (System SRAM)

Table 3.5

Program placement in flash memory and load destination address (16-bit bus boot mode)

Flash memory address

Contents

Load destination address

0x7000_0000

Parameters for the loader

0x7000_004C

Loader program

0x0010_2000 (BTCM)

0x7008_0000

Loader table

0x7010_0000

Application program

0x1001_0000 (System SRAM)

RO1AN6737EJ0210 Rev.2.10
Jun 16.2025
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3.3.2 Section Assignment in Sample Program

3.3.2.1 EWARM

Table 3.6 shows the memory sections used by the loader program, and Table 3.7 shows the sections
used by the application program. These sections are defined in the linker script.

Table 3.6 Sections used by loader program

Area Name Description Storing/Execution
Area*
LOADER_PARAM_BLOCK Parameters for the loader Flash
PRG_RBLOCK Code area (for storing) Flash
USER _DATA_RBLOCK Variable area (for storing) Flash
PRG_WBLOCK Code area (for execution) BTCM
USER_DATA_WBLOCK Variable with initial value area (for execution) BTCM
USER_DATA_ZBLOCK Variable without initial value area (for execution) | BTCM
APPLICATION_PRG_RBLOCK | Application program area (for storing) Flash

APPLICATION_PRG_WBLOCK

Application program area (for execution)

System SRAM

Note
memory is storing area.

Table 3.7 Sections used by application program

In xSPI0 boot mode, serial flash memory is storing area. In 16-bit bus boot mode, NOR flash

Area name Description Storing/Execution
Area*
PRG_RBLOCK Code area (for storing) Flash
USER_DATA_RBLOCK Variable area (for storing) Flash
PRG_WBLOCK Code area (for execution) System SRAM
USER _DATA_WBLOCK Variable with initial value area (for execution) System SRAM
USER _DATA_ZBLOCK Variable without initial value area (for execution) | System SRAM

Note

In xSPI0 bus boot, serial flash memory is storing area. In 16-bit bus boot mode, NOR flash
memory is storing area.

RO1AN6737EJ0210 Rev.2.10
Jun 16.2025

RENESAS

Page 13 of 34



RZ/N2L Group

Example of separating loader program and application program projects

3.3.2.2 e?studio

Table 3.8 shows the memory sections used by the loader program, and Table 3.9 shows the sections
used by the application program. These sections are defined in the linker script.

Table 3.8 Sections used by loader program(e? studio)

Area Name Description Storing/Execution
Area™

loader_param Parameters for the loader Flash
flash_contents Code area (for storing) Flash
flash_contents Variable area (for storing) Flash
text Code area (for execution) BTCM
.intvec
.reset_handler
Joader_text
.data Variable with initial value area (for execution) BTCM
.rodata
.bss Variable without initial value area (for execution) | BTCM
IMAGE_APP_FLASH_section | Application program area (for storing) Flash

IMAGE_APP_RAM

Application program area (for executing)

System SRAM

Note

Table 3.9 Sections used by application program(e? studio)

In xSPI0 boot mode, serial flash memory is storing area. In 16-bit bus boot mode, NOR flash
memory is storing area.

Area name Description Storing/Execution
Area™

flash_contents Code area (for storing) Flash

flash_contents Variable area (for storing) Flash

text Code area (for execution) System SRAM

.intvec

.reset_handler

Jloader_text

.data Variable with initial value area (for execution) System SRAM

.rodata

.bss Variable without initial value area (for execution) System SRAM
Note In xSPI0 bus boot, serial flash memory is storing area. In 16-bit bus boot mode, NOR flash

memory is storing area.

RO1AN6737EJ0210 Rev.2.10
Jun 16.2025
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3.3.3 CPU MPU Settings

Table 3.10 shows the CPU MPU settings for areas accessed by CPU in this sample program. These
setting are applied during startup processing of the application program.

Table 3.10 CPU MPU Settings

0x1017_FFFF

Contents Address Memory type
System SRAM 0x1000_0000 | Area2
to Normal, cache enabled, non-shared

System SRAM (mirror area)

0x3000_0000
to
0x3017_FFFF

Area 4
Normal, cache disabled, shared

Extended address space (mirror
area)

xSPI0, xSPI1

CS0, CS2, CS3, CS5

0x4000_0000
to
Ox5FFF_FFFF

Area 5
Normal, cache disabled, shared

Extended address space
xSPI0, xSPI1
CS0, CS2, CS3, CSs5

0x6000_0000
to
Ox7FFF_FFFF

Area 6
Normal, cache enabled, non-shared

Non-safety peripheral modules

0x8000_0000
to
Ox80FF_FFFF

Area 7
Device (nGnRE), instruction fetch disabled

Safety peripheral modules

0x8100_0000
to
O0x81FF_FFFF

Area 8
Device (hnGnRE) , instruction fetch disabled

3.3.4 Exception Processing Vector Table
Exception level 1 of RZ/N2L has 7 types of exception processing (reset, undefined instruction, SVC,
prefetch abort, Data abort, IRQ and FIQ exceptions) that are allocated to the 32-byte area starting from
specified offset address. Specify a branch instruction to each exception processing in the exception

processing vector table.

Table 3.11 lists the contents of exceptional processing vector table for this sample program. Modify the

setting to suit your needs.

Table 3.11  Exception Processing Vector Table

Exception Handler Address*1 Remark*2
RESET Offset Branches to startup program
Undefined instruction Offset + 0x0000 00004 Branches Defaul _Handler
SvC Offset + 0x0000 00008 Branches Defaul_Handler
Prefetch abort Offset + 0x0000 0000C Branches Defaul_Handler
Data abort Offset + 0x0000 00010 Branches Defaul_Handler
Reserved Offset + 0x0000 00014 Branches Defaul_Handler
IRQ Offset + 0x0000 00018 Branches IRQ_Handler (Used for interrupt)
FlQ Offset + 0x0000 0001C Branches Defaul_Handler

Note 1. The offset is defined as following in the sample program.

Loader program
Application program

: 0x0010_2000
: 0x1001_0000

2. Software break instruction is executed in Default_Handler.

RO1AN6737EJ0210 Rev.2.10
Jun 16.2025
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3.4 Function Specifications
This section describes the function specifications.

3.4.1 system_init
system_init
Overview System initialization 1.
Declaration void system_init (void)
Description Executes system initialization such as setting the exception handling vector table
offset and changing Exception Level to 1 from 2. After that, branches to stack_init.
Arguments None
Return value None
Remarks After boot processing, this function runs as startup process.

3.4.2 stack_init

stack_init
Overview System initialization 2.

Declaration void stack_init (void)

Description Executes system initialization such as initializing the stacks, FPU, clock, variables
for startup process, CPU MPU, cache, and ports. After that, branches to the main
process.

Arguments None

Return value None
Remarks None

3.4.3 hal_entry

hal_entry
Overview Main process.

Declaration void hal_entry (void)

Description e Loader program: Copies the application program to internal RAM. Turns on
LEDO before copy processing and turns on LED3 after copy processig is
complete.

e Application program: Blinks LED3 with software interrupt (INTCPUO).

Arguments None

Return value None
Remarks None

RO1AN6737EJ0210 Rev.2.10

Jun 16.2025
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3.4.4 bsp_copy_multibyte
bsp_copy_multibyte

Overview Copy function.
Declaration void bsp_copy_multibyte (uintptr_t *src, uintptr_t *dst, uintptr_t bytesize)
Description Copies data for the size specified by the argument.
Arguments e uintptr_t *src: Copy source address.

e uintptr_t *dst: Copy destination address.
e uintptr_t bytesize: Copy data size.

Return value None
Remarks None
RO1AN6737EJ0210 Rev.2.10 Page 17 of 34
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3.5 Flowchart

3.5.1 Loader Program
3.5.1.1 system_init

Figure 3.4 shows flowchart of system_init in the loader program.

< system_init >

EL2 initialization

Initialize in EL2.

EL1 exception vector table offset
setting

Set the offset of the exception vector table used
in the loader program.

LLPP permission setting

Enable LLPP access.

Return from EL2 to EL1

Save CPSR and move to EL1 with ERET instruction.

( stack_init > Branch to stack_init.

Figure 3.4

system_init processing (loader program)

RO1AN6737EJ0210 Rev.2.10
Jun 16.2025
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3.5.1.2 stack_init

Figure 3.5 shows flowchart of stack_init in the loader program.

( stack_init >

. Set the stack pointer for each proessor mode
Stack setting (System, FIQ, IRQ, Supervisor, Abort, Undefined).
FPU setting Set FPU operation permission.
Clock setting Set the clock.

Initialize variables with initial values and

Initialize variables used in the clear variables without initial value used in the program.
program
Update SYS_teQIW core clock Update system core clock variable to the current CPU frequency value.
variable

Initialize static constructor.

Initialize static constructor This process is required for C++ projects.

Port setting Set I/O port registers.

< hal_entry > Branch to hal_entry.

Figure 3.5 stack_init processing (loader program)
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3.5.1.3 hal_entry

Figure 3.6 shows flowchart of hal_entry in the loader program.

< hal_entry >

Disable port protection

Enable writing to registers related to 1/0 port.

Turn on LEDO Turns on LEDO to signal the start of copy processing.

Copy the applicationprogram to System SRAM

Copy application program from from external flash memory
external flash memory to RAM accoding to the parameters of loader table.
Turn on LED3 Turns on LED3 to signal the end of copy processing.

Enable port protection

Disable writing to registers related to 1/O port.

< app_prg > Branch to application program.

Figure 3.6  hal_entry processing (loader program)
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3.5.2 Application Program
3.5.2.1 system_init

Figure 3.7 shows flowchart of system_init in the application program.

< system_init >

Set the offset of the exceptionvector table used
EL1 exception vector table offset in the application program.

setting

< stack_init > Branch to stack_init.

Figure 3.7  system_init processing (application program)
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3.5.2.2 stack_init

Figure 3.8 and Figure 3.9 show flowchart of stack_init in the application program.

( stack_init >
Set the stack pointer for each proessor mode

Stack setting (System, FIQ, IRQ, Supervisor, Abort, Undefined).

FPU setting Set FPU operation permission.

Clock setting Set the clock.

Initialize variables with initial values and

Initialize variables used in the clear variables without initial value used in the program.
program
Update Sys'teQIW core clock Update system core clock variable to the current CPU frequency value.
variable
CPU MPU, cache setting Configure CPU MPU and cache.

Initialize static constructor.

Initialize static constructor This process is required for C++ projects.

Port setting Set I/O port registers.

(]

Figure 3.8  stack_init processing (1/2) (application program)
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|

Semaphore setting

Configure semaphore function.

Master MPU setting Set Master MPU registers.

Global system counter setting Enable global system counter.

Initialize interrupt controller.
Interrupt setting

TFU setting Configure TFU.

( main > Branch to main, then branch to hal_entry.

Figure 3.9  stack_init processing (2/2) (application program)
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3.5.2.3 hal_entry

Figure 3.10 shows flowchart of hal_entry in the application program.

( hal_entry >

Software interrupt setting

Configure software interrupt (INTCPUOQ).

Generate software interrupt (INTCPUO).
After generating software interrupt,

G te soft int t . Lo
enerate software inferrup intcpu0_handler processing is executed.

Software delay Delay by software.

Figure 3.10  hal_entry processing (application program)
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Figure 3.11 shows flowchart of interrupt processing in the application program.

( intcpu0_handler >

Disable port protection Enable writing to registers related to 1/0 port.
Blink LED.
If LED is on, turn off LED.
Turn on/off LED3 If LED is off, turn on LED.
Enable port protection Disable writing to registers related to 1/O port.

< return > Return to application main processing.

Figure 3.11 interrupt processing (application program)
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4. Related Documents

e User’'s Manual: Hardware
RZ/N2L Group User's Manual: Hardware
Download the latest version from the Renesas Electronics website.

Renesas Starter Kit+ for RZ/N2L
Download the latest version from the Renesas Electronics website.

e Technical Update/Technical News
Download the latest version from the Renesas Electronics website.

e User's Manual: Development Environment
The latest version for the IAR integrated development environment (IAR Embedded Workbench® for
Arm) is available from the IAR Systems website.
The latest version for the Renesas Electronics integrated development environment (e? studio) is
available from the Renesas Electronics website.

R0O1AN6737EJ0210 Rev.2.10 Page 26 of 34



RZ/N2L Group Example of separating loader program and application program projects

5. Appendix Supplementary Notes on Development Environments

This section shows the steps up to the start of debugging of the sample program in each of the available
development environments. The following is an example using the xSPI0 boot mode version.

5.1

Debug procedure for this sample program.

5.1.1 EWARM from IAR systems

1.

Launch EWARM and open "RZN2L_bsp_xpiObootx1_app_loader.eww" with following procedure.
"[File] -> [Open Workspace] -> select Loader_application_projects\RZN2L_bsp_xpiObootx1_app_loader.eww

Select "RZ/N2L_bsp_xspiOboot1_app" project in Workspace box as Figure 5.1.
And run build with "[Project] -> [Rebuild All]"

Then, select "RZ/N2L_bsp xspiOboot1_loader" project in Workspace box.
And run build with "[Project] -> [Rebuild All]"

Make sure that your PC and RZ/N2L evaluation board are connected with I-jet.
Then, start debugging with "[Project] -> [Download and debug]"

After emulator connecting, both loader program and application program are downloaded to external
serial flash memory by Flash Downloader. After downloading is complete, the debugging is started
(Program starts running).

@ RZNZL_bsp_xspilbootx1_app_loader - IAR Embedded Workbench IDE - Ar
File Edit WView Project I-jet Tools Window Help

00 @ = Al

RZM2ZL_bsp_xspilboots1_app - Release
RZMNZL_bsp xspi0bootx1_loader - Debug
RZMN2L_bsp xspilbootx1_loader - Release

[ T e T E e R R TR T

® RZN2L_bsp_xspilbootd .. v

Figure 5.1  Project selection
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NOTE: Select the loader project when you start debugging as Figure 5.2.
Application program is already specified as extra image in loader project option.
"Right click loader project -> [Options...] -> [Debugger] -> [Images] -> [Download extra image]"

Options for node "RZN2L_bsp_xspiObootx1_loader”

Category:

Factory Settings
General Options ~

Static Analysis
Runtime Checking
C/C++ Compiler Setup Download Images Multicore Extra Options Plugins
Assembler
Qutput Converter

[Download extra image

Custom Build Path: $PROJ_DIR$¥. ¥application¥Debug¥Exe¥RZN2L_bsp_xspi0
Build Actions
Linker Offset: |0
Simulator [J Download extra image
CADI
CMSIS DAP
GDB Server Debug info only
I-jet

J-Link/)-Trace
TI Stellaris
Nu-Link

PE micro
ST-LINK Debug info only
Third-Party Driver

[ Debug info only

[J Download extra image

0K Cancel

Figure 5.2 EWARM option setting.
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5.1.2 e? studio from Renesas

1. Launch e? studio with your workspace. Then, click as following.
"[File] -> [Import...] -> [General] -> [Existing Projects into Workspace] -> [Next >]"

n

Then, click "[Finish]"

3. Run build with "[Project] -> [Build All]"

Select “[Select archive file]” and Browse "gcc\xspiObootx1\Loader_application_projects.zip".

4. Make sure that your PC and RZ/N2L evaluation board are connected with J-Link. Then, select
“RZ/N2L_bsp_xspiObootx1_loader” in connection setting and start debugging with "[Debug]"

5. After emulator connecting, both loader program and application program are downloaded to external
serial flash memory by Flash Downloader. After downloading is complete, the debugging is started

(Program starts running).

NOTE: Select the loader project when you start debugging. With the following debug configuration,
the loader program and application program are written to the external serial flash memory
at the same time when the loader project is connected for debug.

ﬁ Debug Configurations

FoaREX BT~

Create, manage, and run configurations

[m] X

&

Name: ‘RZNZL_bsp_xspit)bootm_loadel Debug_Flat

‘type filter text

[&] C/C++ Application
[&] C/C++ Remote Application
L= EASE Script

‘ 2 Main %Dsbuggel_ & Source| ] Common

Initialization Commands

[JReset and Delay (seconds): 3

[€] GDB Hardware Debugging [Halt
[E] GDB OpenOCD Debugging
[E] GDB Simulator Debugging (RH850)
i Java Applet
[0 Java Application Load-mege-snd o
Li h Gi
g aunch broup — Filename Load type Offset (h.. On conn...
'l Remote Java Application . Add...
« [ Renesas GDB Hardware Debugging Program Binary [RZN2L bsp xs.. Image and Sy. Yes i
9 RZN2L_bsp_xpiObootx1_app Debug_Flat RZN2L _bsp_xpiObootx1_app.elf.. Image and Sy... Yes Edit
[ RZN2L_bsp_xspi0bootx1_loader Debug_Flat Remove
[E] Renesas Simulator Debugging (RX, RL78) S ——
Vlove up
Move down
Runtime Options
[[] set program counter at (hex):
Set breakpoint at:
] Resume
............ 5
Filter matched 14 of 16 items evert APPlY
Figure 5.3  Debug configurations in e? studio
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5.2 Example of changing RAM placement in application program

The sample program copies the application program from the source address to the destination address
specified in the loader table. The user can change the placement of the application program by rewriting

the source and destination addresses as necessary.

5.2.1 EWARM from IAR systems

Below is an example (xspiOboot project) of changing the placement for application program from System

SRAM to ATCM.

fsp_xspi0_boot_loader.icf (Linker script for loader program)

Default

/* Internal memory */

define region BTCM_LDR_region = mem:[from ©0x00102000 size 56K];
define region APPLICATION_RAM_region = mem:[from 0x10010000 size 64K];

/* Flash memory */
define region LOADER_TABLE_region = mem:[from 0x60080000 size 64K];
define region APPLICATION_ROM_region = mem:[from 0x60100000 size 64K];

l

After changing

~n

/* Internal memory */
define region BTCM_LDR_region = mem:[from 0x00102000 size 56K];

address to ATCM */

/* Flash memory */
define region LOADER_TABLE_region = mem:[from Ox60080000 size 64K];
define region APPLICATION_ROM_region = mem:[from 0x60100000 size 64K];

~an

define region APPLICATION_RAM_region = mem:[from 0x00000000 size 64K]; /* Change copy destination

fsp_xspi0_boot_app.icf (Linker script for application program)

Default
place at start of SYSTEM_RAM_PRG_region { block PRG_WBLOCK };
place in SYSTEM_RAM_PRG_region { block USER_DATA_WBLOCK };
place in SYSTEM_RAM_PRG_region { block USER_DATA_ZBLOCK };
place in SYSTEM_RAM_PRG_region { rw data,

rw section .sys_stack,

rw section .svc_stack,

rw section .irq_stack,

rw section .fiq_stack,

rw section .und_stack,

rw section .abt_stack };
place in SYSTEM_RAM_PRG_region { rw section HEAP };~~~

After changing

~a~

place at start of ATCM_region { block PRG_WBLOCK }; /* Change code area to ATCM */
place in ATCM_region { block USER_DATA_WBLOCK }; /* Change data area to ATCM */
place in ATCM_region { block USER_DATA_ZBLOCK }; /* Change bss area to ATCM */
place in ATCM_region { rw data, /* Change stack area to ATCM */

rw section .sys_stack,

rw section .svc_stack,

rw section .irq_stack,

rw section .fiq_stack,

rw section .und_stack,

rw section .abt_stack };
place in ATCM_region { rw section HEAP }; /* Change HEAP area to ATCM */
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5.2.2 e? studio from Renesas

Below is an example (xspiOboot project) of changing the placement for application program from System
SRAM to ATCM.

fsp_xspi0_boot_loader.ld (Linker script for loader program)

Default

~an

.IMAGE_APP_RAM 0x10010000 : AT (0x10010000)

IMAGE_APP_RAM_start = .;
KEEP(*(APP_IMAGE_RAM))

.IMAGE_APP_FLASH_section 0x60100000 : AT (©x60100000)

IMAGE_APP_FLASH_section_start = .;
KEEP(./src/Flash_section.o(.IMAGE_APP_FLASH_section))
IMAGE_APP_FLASH_section_end = .;

l

After changing

~an

.IMAGE_APP_RAM 0x00000000 : AT (0x00000000) /* Change copy destination address to ATCM */

{
IMAGE_APP_RAM_start = .;
KEEP(*(APP_IMAGE_RAM))

}

.IMAGE_APP_FLASH_section 0x60100000 : AT (©x60100000)

{
IMAGE_APP_FLASH_section_start = .;
KEEP(./src/Flash_section.o(.IMAGE_APP_FLASH_section))
IMAGE_APP_FLASH_section_end = .;

}

fsp_xspi0_boot_app.Id (Linker script for application program)

Default

.text 0x10010000 : AT (_mtext)
{

} > SYSTEM_RAM
.rvectors :

~n

} > SYSTEM_RAM
.ARM.extab :

{
} > SYSTEM_RAM
.ARM.exidx :

~rn

} > SYSTEM_RAM
.got :
{

} > SYSTEM_RAM
.data : AT (_mdata)

~rn

} > SYSTEM_RAM
.bss :

~n

} > SYSTEM_RAM
.heap (NOLOAD) :

~rn
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{

} > SYSTEM_RAM
.thread_stack (NOLOAD):

~rn

} > SYSTEM_RAM
.sys_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.svc_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.irq_stack (NOLOAD) :
{

} > SYSTEM_RAM
.fig_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.und_stack (NOLOAD) :

~rn

} > SYSTEM_RAM
.abt_stack (NOLOAD) :

~ron

} > SYSTEM_RAM

~rn

~rn

~an

l

After Changing

.text 0x00000000 : AT (_mtext) /* Change code area to ATCM */
{

} > ATCM
.rvectors :

~on

} > ATCM
.ARM.extab :

~n

} > ATCM
.ARM.exidx :

~n

} > ATCM
.got :

~on

} > ATCM
.data : AT (_mdata) /* Change data area to ATCM */
{

} > ATCM
.bss : /* Change bss area to ATCM */

~on

} > ATCM
.heap (NOLOAD) : /* Change heap area to ATCM */

~n

~rn

} > ATCM
.thread_stack (NOLOAD):

~n

} > ATCM
.sys_stack (NOLOAD) : /* Change stack area to ATCM */
{
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} > ATCM
.svc_stack (NOLOAD) :
{

} > ATCM
.irq_stack (NOLOAD) :
{

} > ATCM
.fig_stack (NOLOAD) :
{

} > ATCM
.und_stack (NOLOAD) :
{

} > ATCM
.abt_stack (NOLOAD) :

~ron

} > ATCM
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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